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1.1AE250 f&ifr
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1.1 AE250 &4y

AE250 22—/ 32 fif RISC-V MCU %%, HEZELEMWNE 1-1 .

E 1-1 AE250 Z&34EE

Platform .
e < Interrupt ROM/ 4—Inst Data

Controller A ZA0S Bus Interface | ______
master slave

CPU AXI/AHE APB | X
Subsystem P P | EPEEA

H-T Gowin FPGA H & ] RISC-V MCU FH &R &2 G & 1-2 Fizs o
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B 1-2 &/ R G EEE

Gowin FPGA Dev Board PC
$ GOWIN
PROGRAMMER
SPI flash
rt 1
\ 4 pa
FGPA chip S?ai'zsh < Andesight RDS
AE250_chip
Flash Burner
<
ILM
- < > < » Download
< »| Peripherals
» »| DEBUG ¢ »  Debug
DEBUG CABLE
UART > »  Virtual Hosting
A
UART
Terminal
A

i PC i f Gowin Programmer ¥ & b ) FPGA it F R & A

AE250 MCU, i##:4F Debug Cable, H i PC i) Andesight %47
RN TR 7 I R AT A

1.2 ERTE

A

7EfH Gowin FPGA+AE250 AT KA /I, FE &L LA

Gowin GW2A %71 FPGA Jf &K1 ;

Gowin IDE =84 dets, FHTHECEM T % FPGA & ;s

Andesight e3¢, AT IH RN T ;

Debug Cable, T T#. Wik AR, 4L ## Debug Cable
a). AICE mini V2.0, ~NEkIASZFF) Debug Cable;

b). Olimex arm usb tiny h, A% =77 ] Debug Cable, 7E %%
Andesight 2 | B 47 2% libusbK, 2235771 WA 2.2,

R FEIEL UART #it{E 5, WFHHES—% UART # USB £;
A FH B AN BT T W

2(20)




A
=
il

1.3 R B

1.3 A%/ AR E

1§ 3T GW2A-18 JF & #U#) RISC-V MCU HEAT I & R VR (K A

IRUR
1. L. GOWIN IDE =iE:, FFEEMA K AE250 1) RTL it

N

HAE A% B bitstream SCF; Andesight #c44:, P AT RN AR
FIFF R AN AR HAR BT 7 B B Ak 5] .

e & F AR ) E YR AT R 32k, i GOWIN PROGRAMMER 4
AE250_chip [ bit-stream S T #EIHF AR 8 FPGA & v, i
AE250 {EH KR FiaAT;

A Andesight, HTE R AR TRESEFT A K LR, H1Tmig.
g . ERE AE250 IR ) DEBUG CABLE, ¥ T2 14w P45
R EF AE250 H T ILM (84 A7 fiE7s) ., FragH Bt

IR, "] L#EH UART % USB [ CABLE ¥ AE250_chip ] UART #%
R3] PC i, i Andesight Hr A B Ef 1 2 am ik A7 5 A\ HH ER A
o # f# F Virtual Hosting Zhig, ¥4 15 4T EITE console H (P LA
X 3.7). AJLMEF] GPIO &% LED f87R47 « fetal F oMEtdst ., DA
HEAT I NS AE, BAMEA 12C. SPI. Ethernet £54h 5 al ¥EHAE ] ;
AE250 MCU 7] LLidiid SPI 4ME—4 Flash, i#id Andesight + Debug
Cable ¥ fix N A2 7945 R T #02 Flash o, 7687 EHJE, AE250
MCU Hzl M SPI Flash H 3 lUR A XL I /A 8. AT LUK LR1E FPGA
Bitstream [ Flash #4T7 &2 H, —#&k7 HKIRAF FPGA Bitstream, 73—
A RN R T IO IR g . X2 — Rl Lb s B& B0

VRN I AL A 4115 2 WL 5K . 5 RISC-V Debug Cable #4157, =
% Andesight RDS i FH 451 LA &5 DY 2 T AR AR S TR o

IPUG546-1.0
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2RISC-V Debug Cable %15/ 2.1AICE-MINI DEBUG CABLE

2RISC—V Debug Cable #iEiER

A PiFr RISC-V DEBUG Cable A fiti%#%, AICE MINI DEBUG CABLE
5% OLIMEX ARM-USB-TINY-H CABLE.

2.1 AICE-MINI DEBUG CABLE

LTS H) Andesight BRI H /2 AICE-MINI DEBUG CABLE, f4t
WL D, EIRA 5 AR, S 12 PIN B2 1. JER R 2k
) PIN 29 PIN 1. 243820 ERESIFFTIT Andesight Bt s, B4 A (4
THEFRIERIZL L LED 4T 258K

[ 2-1 AICE MINI DEBUG CABLE KR HEHS|BIrEE

AICE-MINI DEBUG CABLE HJ5| e Lk 2-2, & PIN 1 HE XN
NC (No Connection), %} M 25 5[] PIN 1.VREF 78— 3.3V HE G| i,
3/5 Y] GND R FHiERE—AEIH],

IPUG546-1.0 4(20)




2RISC-V Debug Cable ##: 45

2.20LIMEX ARM-USB-TINY-H CABLE

& 2-2 AICE 3|BENX

=
5
+

AICE mini debug cable pin

NC

TSRST N

GND

TTMS

GND

TCK

VREF

00 [=J |G |0 | [0 [P = [

NC

w

NC

=
=]

TTRST N

11

TTDO

12

TTDI

2.2 OLIMEX ARM-USB-TINY-H CABLE

L HTRCAS ) Andesight 2Rl 7 F£ 1 Debug Cable 24 AICE-MINI CABLE,
IR 75 E4E ] Olimex ARM-USB-TINY-H, %3 Andesight 2 |, %5623k
—A™ libusbK, e Zadig BEATHRGE 2205, R iEMI R
1. F# Zadig, HT %% libusb. TF#Mhhk: https://zadig.akeo.ie/;

2. Olimex Cable #H7E HLfw I, HLES A] PL7E R 255 #E 4% B 3] Olimex Cable,
H BRI (F& FAEOERN SR,

3. Xl Zadig.exe, fTJF LA, a1l 2-3 iR
& 2-3 ¥TFF Zading

E Zadig

Device Options Help

Driver |

| C‘} |WinUSB (v6.1.7500. 16385) |:

w2 D

0 devices found.

USE ID I:II:I

Install WCID Driver

i Edit

More Information
WinUSE (libusb)
libusb-win32

libushi

WinUSE (Microsoft

a). riir Options>List All Devices,

2'4 Fﬁﬂ—_\Ao

IPUG546-1.0
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2RISC-V Debug Cable ##: 45

2.20LIMEX ARM-USB-TINY-H CABLE

IPUG546-1.0

. A
& 2-4 Device IR
El Zadig - X
Device Options Help
Olimex OpenOCD JTAG ARM-USB-TINY-H {Interface 0) ~ | [JEdit

Driver | libusbk (v3.0.7.0) | =

we 2 E

& devices found.

WinUSE {v6. 1.7600.16335)

Replace Driver hi

More Information
WinUSE (libusb)
libusb-win32

libushi¢

WinlSE (Microsoft

b). Olimex OpenOCD JTAG ARM-USB-TINY-H(Interface 0)#1 Olimex
OpenOCD JTAG ARM-USB-TINY-H(Interface 1)% % libusbK ZXzj,

& 2-5 s
& 2-5 &% libusbK IXzH

El Zadig

Device Options Help

Qlimex OpenQCD JTAG ARM-USB-TINY-H {Interface 0)

Driver |IibusbK (v3.0.7.0)

wemn 2 E

6 devices found.

| = |IihusbK (v3.0.7.0)

Reinstall Driver hd

- More Information

~ | ] Edit

WinUSE {ibusb)
libush-win32
libushi

WinlSE (Microsoft

c). LIEFERJGE, BILATE windows

WEE 2 EE T Olimex

OpenOCD JTAG ARM-USB-TINY-H ¥ %, B AFHERE %S
W, FORIBI O AL IR, WK 2-6 AR.

Bl 26 EREEEBRER libusbK RE

= eEsEE
THO B SEW w8
> @ HEl e

(o fe /=]

4 .= GW-5W-058
4§ libusbK USE Devices

> P weigE

> B EiEEE

> [ =S

by IR

> G RIS

» ¥F &0 (COM #1 LPT)

1 | 1

‘g Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 0)
- Olimex OpenOCD JTAG ARM-USB-TINY-H (Interface 1)

»

|.m
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2RISC-V Debug Cable ##157

2.20LIMEX ARM-USB-TINY-H CABLE

IPUG546-1.0

Olimex Cable #MlE K, WK 2-7 Fis.
& 2-7 Olimex Cable 4P M~ =E

V i

This note indicates
PIN1 of the cable

Olimex Cable 5] filE X &, Wik 2-8 Fix.
[&] 2-8 Olimex Cable 5|BE X E

JTAG connector pinout

PIN #|Signal name PIN #|Signal name
1|VREF 2| VREF
3| TTRST_N 4 GND
5(TTDI 6| GND
7| TTMS 8| GND
9| TTCK 16 |GND

11 | TRTCK 12 |GND
13| TTDO 14 | GND
15| TSRST_N 16| GND
17 |NOT CONNECTED 18| GND
19| TARGET SUPPLY 28| GND

Hrh, VREF 7% 3.3V #HIE 5] i, 4/6/8/...120 /] GND R &R —1
Rpey Caf PL#EHE J3-2 81 J3-20).
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3Andesight RDS fii 355

3.1Andesight RDS %%

3Andesight RDS £/ iEF

3.1 Andesight RDS &%

AR JE3E N Windows/Diskl, XUifi setup.exe 4T %%, 22350

ANTE B IR B E, AR 22 B RS b oA B HH O A O ) 2 1 2 AR, T IR
whe . HM 3P BE S ROO:

AndeSight_ RDS_v3.1_Installation_Guide _UM171_V1.1.pdf, AJ7E %% 41
LR

1.

3.2 FETIE

W B BB AL A T AE 23 6] (workspace ) Bg 4 I, 115 AN AL & I 7 B 1%
IS AT I 2 H RS %5

LHT A Andesight BRI\ SZ F7) Debug Cable v AICE-MINI Cable,
B FH IS ] Olimex ARM-USB-TINY-H, i5Z A 2.2 #4;

%% Andesight RDS 2 J&, W< il GOWIN Programmer JoikiE+z
TR R, HHEIE Gowin IDE Ji5 55357 22 25 BV A] 45 B i i 7

Andesight RDS f{] Public Key S 2Lzt i,  Wnss e 415 AE+
YA, 15 % Gowin Semiconductor Corp. Hii% .

7E Andesight #1fj I fi 5 File->New->Project->Andes C project->Next,

BEANWTE C TREMEE S, K 3-1 s,

IPUG546-1.0
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3Andesight RDS fi 5 R 3.2 W TR

IPUG546-1.0

E 3-1 fiETis

A C Project = =]
C Project p—

Create C project of selected type

Project name: demo_0
Use default location
C:\Users\root\AndeSight3\workspace\demo_0 Browse...
default
Connection Configuration

Chip Profile

Chip Profile Name Chip ID CPU  Simulator Config
ADP-AE250-N25-GOWIN ADP-AE250-N25-GOWIN [N25] ADP-AE250-N25wvep

Project type: Toolchains:

4 = Andes Executable [*inds32le-elf-mculib-v5m
® Empty Project
@® Hello World ANSI C Project
® demo_ae250_exFlash_gowin

> (2= Andes Static Library

> [ Makefile project

Show project types and toolchains only if they are supported on the platform

'f?:' < Back ’ Mext = I l Finish ] ’ Cancel

TRELEN ST
T4
RAEALE, BUIALE 2 M TTH) workspace;
Connection Configuration, &N ICE, F/~{#H ICE debug cable %
BT R WA H 07 BB AT NI &, 15 1E$ SID;

4. Chip Profile, i& % ADP-AE250-N25-GOWIN, iX &R # GOWIN FPGA
HATALECE T 1 Chip Profile;

5. Project Type, &7 % LTFEM Hello World T/, FATENE T AL

ik demo_ae250 exFlash_gowin. iXj&— M4 T A BSP.
bootloader. start.S %5 Py 78 ) T FEARHR ;

Wi TREJS, 7F Project Explorer T4 I ARS8, 75 NHsgs
HRi% £ build project Bl B B2 1% P EEEE Ctrl-B X TREFH T4 3 BEE S 81 .
£ N RSE L %k F clean project 7] #E47 make clean HIHEAE .

!
U RAEH )2 Olimex ARM-USB-TINY-H CABLE, W5 BT %260k, ES 0. 2.2, JF
B H target configuration “A-1 olimex-arm-usb-tiny-h.cfg, 1k 3-2 fis.

9(20)




3Andesight RDS 1§ il #&

33 BN/FHTRE

& 3-2 % & Debug Cable A Olimex ARM-USB-TINY-H

B Project Exploreniia
(=5 28250-demn
13 Chip Profil
7 demo-hsp
@ demo-iicn
© demo-iic-s &
3 demo-pfm
0 demo-plic: %
3 demo-plic
@ demo-pow
@ demo-prin
3 demo-sd-¢
0 demo-wii-! 22

45 Debug 53

EP\

v i ae250-den
v B Process
v @ Thre

B

o gdb(71

=5

New
Show in Local Terminal

Copy
Paste
Delete
Source
Move...

Rename...

Import...
Export...

Build Project
Clean Project
Refresh
Close Project
Make Targets
Index

Build Configurations

Build Settings
Target Configuration

Flash Burner

Run As

Debug As

Profile As

Compare With

Restore from Local History...
File Explorer

Configure

D

3.3 B8NBHIE

IPUG546-1.0

£ Project Explorer [f7 [ 4b 5o B bR A7

= = B |([Ear
e
>

>

Crl+C
Cirl+V
Delete

>

Ctrl+

Al LEntar

A Properties for ae250-demo

Target Configuration
Resource
Builders -
~ C/C++ Build Configuration: Debug [ Active ]

Build Variables

Environment

~ | Manage Configurations...

Logging Apply to All Configurations.
Settings Chip Profile
Target Configuration EorA o

Browse...

Teol Chain Editor
C/C++ General
Project References Target Settings
Run/Debug Settings Connection Configuration

O |sIp v ® |IcE ~

Arguments Settings

ICE Misc Arguments |-|_olimex-arm-usb-tiny-h.cfg

Clean and Rebuild Project
[ Clean project
1 Build project

@

S

BIATIESE Import ()

B Export (S, HHATTREKSN/ S HEME, W& 3-3 fis.
3-3 Project Explorer

L Project Explorer 2 9% v = 8
LI aez50_demo_exFlash_uart_gpio_pit
1J aez30_demo_mtimer_pit_1
LI aez50_exFlash_2a55_demo_pwm_gpio_0
L] aez50_spi_demo
l=# Chip Profile Editor New 3
LJ demo_ze250_exFlash_gowin
3 demo-hsp-V5 Show in Loca Terminal >
U demo-pfm-V5 Copy Ctrl+C
LI demo-plic-novector-V5 Paste Cirl+V
W demo-plic-V5 3 Delete Delete
LJ demo-powerbrake-V5
Move...
LI Dhrystone-V5
Rename... F2
s Import.
g Export..

SATREMI W 3-4 fror, s Import->General->Existing Project
into workspace R A3 A\ A\ THE S I . 164% Select root directory I}, §A
XA TR 1% Select archive file I, S B4 AN T

10(20)




3Andesight RDS fii 355

33 BN/FHTRE

IPUG546-1.0

E3-4 SATERE

A Import m} X
Import Projects =
Select a directory to search for existing Eclipse projects. E ;J
() Select root directory: Browse...
® Select archive file: || ~ ‘ Browse...
Projects:
Select All
Deselect All
Refresh
Options
Search for nested projects
Copy projects into workspace
[JHide projects that already exist in the workspace
Working sets
[]Add project to working sets
Select...
@ = Back Next = Einish Cancel

S CRER S A 3-5 P,
TR, EFRE S A TR

E 35 SHIERE

1% $ Export...->Archive File, BIa[$TJF
E4gikg . RS SH)E, A5

A Export

Archive file

Export resources to an archive file on the local file system.

L =4
[ = RemoteSystemsTempFiles .cproject
5 demo_ae250 _exFlash_gowin .praject
= ae250.1d
@ ae250.sag
Filter Types... Select All Deselect All
To archive file: |D:\AndEsTech\workspace-std-for-pacl-:age\aeESO_spi_demo.zip v Browse...

Options

(®) Save in zip format
(O) Saye in tar format

Compress the contents of the file

® < Back Next =

(®) Create directory structure for files
(O Create only selected directories

11(20)




3Andesight RDS {# Fi 5 & 3.4 T#FE/7 2| Flash

3.4 T##32~%| Flash

AE250 X FEM flash 530, B3l Jeidid SPI 420 M Flash Az HUm A
NEF IR S ILM 1, RS HEPAT A IR T« HEFE T
1255 H 517 FPGA bitstream [1] SPI Flash, 1§ Flash {87 23570 {5%7% FPGA
(1) bitstream, Ji5 >3 53 ORAT- R N ZURE P (1) — 3k i) ST A

1. FT7F IP generator J+iff i 2411 AE250 ) RTL Z80i% &, X SMU, 4T
JF SMU (i & 7if, K System Reset Vector Default % & K
0x80400000, Nl 3-6 firsn. 4 0~0x400000 3t 4M FH5 4 (A /E AN
bitstream £ 7EHIE, A 0x400000 FF8A1FE A N LR B9 — 31 e i
RN, B2 G, TERERFEITSE;

3-6 I E System Reset Vector Default

Target Device: GNZA-LVEBPG4B4C7/I6
Create In: D: \hndesTeoh'ae?50_eval Otsrolrisorn25 |

Module Name: | ae?BDsoc File Nane: |riseva? |

General Optiens

[ Disable I/0 Current Configure: Default Export CFG | | Inport CFG

07 0] % smu Configuration r x| 0= (= (e

SMJ CSR Base hddvess

SMU CSE Base Address: |0100000

System SCRATCH REG Bysten
Serateh Register Suppert Seratch Register Bit Width
Scratch Register Default Value: |0000000000
Vzer( SCRAICK REG
Scratdl th Fefistar Smpart Seratoh Register Bit Width

Secratch Register Default Value: 0000000000

Vzerl SCRAICH REG

Scratch Regizter Suppert Scratch Register Bit Width 32

Scratch Register Default Value: |0000000000

I

System Reset Vector Default

System Reset Veotor Default: |50400000]

(i1 Cancel Help

2. TEAE RTL BIFMWEZ KA, K SPI1 #1043 SPI Flash |, ¥
SPI1 i) %R N RS TR, 56 AFEK FPGA &, MSPI #
A B RAF R, FF4EHxT BAR S ok AT BRI 45k

IPUG546-1.0 12(20)




3Andesight RDS fii 355

3.4 #4273 Flash

F< 3-1 SPI1 #¥OBLIFR

AE250 SPI1 11 FPGA MSPI 1
CSN MCSN
CLK MCLK
MISO MSO
MOSI MSI

3. ¥ MSPI #: O EHNEE 10, AW : 7E Gowin IDE = IR {4 1 ST
Process % 1, £4HEsd; Place & Route, 7E#fiHISEdk$e
Configuration, i%#% Dual-Purpose Pin #5325 71, /1% Use MSPI as regular
|O e 10T s o i e B m AT TR 1A S A 455

& 3-7 &8 MSPI #EOAEE IO

WAz Configurations

“ Synthesize
General

~ Place & Route

General
woess g X Dual-Purpose Pin
|| Design Summary BitStream

- [} User Constraints
i FloorPlanner
% Timing Constraints Editor
* 5 Synthesize
Synthesis Report
Netlist File
Place & Route
Place & Route Report
Timing Analysis Report
Ports & Pins Report
Power Analysis Report

w .
4 Program Device

Dual-Purpese Pin

D Use JTAG as regular IO
D Use SSPT as regular IO
Usze MSFI az regular IO
D Use READY as regular IO
D Use DONE as regular IO
[] Use RECONFIG W a= regular IO
[ U=e MIDE a5 regular I0

Concel | dosly

4. BBURAREFRSEHE . BB A T bootloader Z4L,
T AE250 FHR A SRR 7 (0 B 3248 AR 2 8T F SAG SCHF E B A R
R AE SAG XXk 71888 . 1T ae250.sag, k%] BOOTLOADER,
B HAEMCN RTL #ith System Reset Vector Default 18, 41/ 3-8 fit
Ne SRIGMEN config.h, FTJT src/bsp/configl/config.h, $£5% & X

IPUG546-1.0

13(20)




3Andesight RDS fi 5 R 3.4 FHFETF| Flash

IPUG546-1.0

BUILD_MODE, ¥ Hf&t~ BUILD_BURN;
3-8 ae250.sag H bootloader S E

4= HEAD 0x00000000
5 {
BOOTLOADER 0x30400000
{
ADDR _ flash start
C * REEP (.bootloader)
10 LOADADDE _ bootloader Imaend

o  SH N HE RTL &4+ System Reset Vector Default FI{E fRFF—5L;
o MBHUmPFERE, AP ANXTIES, EFF build settings, 1%+ Objcopy->General
I, ¥ % —% Disable. (Do not auto-generate output file.)ix — % 3 U 2 1%k ;

HH A R AR, A RN SRR Y ki S

BB UG B RTL Wit B 4 & AT A 25, {3 external Flash 4%
X F#3 FPGA I IFHL, EH:1F DEBUG CABLE, 7£ Andesight HiA5 2 8
th TFE4, 1%+ Flash Burner, 3 H ) 2 wn& 3-9 fiws.

B % . ¥ Flash Controller Address ¥ & 5 0x80000000, I}y SPI
Flash S HE, % Programming Start Address % & N A R LR i
#SC14-7E SPI Flash )%/, R 0x80400000-0x80000000 f)fE, HP
0x400000. riifi Burn #%4H, K%y 1 43%PRIADE i A UFR T B b i) SO
k%] Flash H. AE250 HBHIRE TR IR AL, £ FPGA Wi Jf =
¥ S, FPGA 4:i2HX Flash #7111 bitstream, FECE AN AE250 MCU, )5
AE250 MCU i SPI 2 M Flash #{# NZUFE 7, BB G B 3h T
URIEAT

14(20)




3Andesight RDS fii 355

3.5 i Bk

& 3-9 Flash Burner A EIXEHIZE

A Flash Programming Wizard o &[]
Flashing Driver @
3
Program flash memory of the target. -
Flash Driver

Location: |yl RN -

[Workspace.‘.] ’File System..‘] ’Variables...]

Flash Image
Location:  C\Users\root\AndeSight3\workspace\test000\Debug\output\test000.bin

[Workspace.‘.] ’File System..‘] ’Variables...]

Programming Start Address: 0x00400000

Driver Arguments

Target board: - Flash Controller Address: 0x80000000

[FUnlock ] Lock After Programming
|| Verification [ | Erase All

Misc Arguments:

Logging

'i?;' & Burn l ’ Close

3.5 i L

IPUG546-1.0

SRR, LUK TR 05 5 LT BRI A AT

e

7t Project Explorer T4 b MAs i t#, 78 N hg ik Debug
As->MCU Program, & —RHAT IEHAE I 2258 0 iEAE, BT & Debug

Configuration, 41l 3-10 ffizr.
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3Andesight RDS fii 355

3.5 i Bk

[# 3-10 Debug ¥ E R |

A Debug Configurations

TIEEN
type filter text
4% Application Program

a 4§ MCU Program
4 demo_0 Debug

Create, manage, and run configurations

MName: demo_0 Debug
[E] Main | %5 Debugger | I Startup 4 Tracer| B Source| [C] Common | #f Exception Handling

1. GDB Initialization Commands
[¥| Reset and Hold

IPUG546-1.0

. load
“#a Target Monitor o3

2. Binary File Options
[ Load binary file

3. Runtime Options

[7] Set program counter at (hex):

Set breakpoint at: main

4. GDB Run Commands

[ Revet || Appl |

Filter matched 4 of 4 items

"/'?j' [ Debug ] I Clase I

£ Startup #3257, 4)i% Reset and Hold &5 7] LALFE FAE T 4RI 4T
IS TEAT 35— 2% F8 2 2 Al k. TEZERTUT 7 IS HHE N load, FRIRTE
BN ERZ TR N SRR 4 B4l T 3BTRS A4S ILM

#£ Runtime Options /4% Set breakpoint at, £ AKE 4 A — M5k
2% (Hedn main), AT LAZE main B EOT 46 7 5 B — M A, A1 Resume
W= fEHEN R FIRE B M 821E1T

AR BRI, 2 E 3T debug MR, ATLLE UK
3-11 — X3, XN B ERAE X, Z0AE A oy — S i 2P
M, MWAERIAL R HEFMG DEBUG. 4k8HsfT. #fs. 450, Wy
FHEERE . BB — AR (B oK, RaAREATTHD AT REL (step
into). 4T T —45#8 4 (step over). ki 7 %L (step return, BLE K,
FoREATHD. HEIEAETHR (instruction stepping mode, 7E AR
T, BIRIEAT % risc-v ILgm1E 4, BMERKIZIT—% CIEFEAD.

5HAh Eclipse BAFRAHE, AEAHS SCAR ZEMAT 5 b XU 5 bR Ac 8l ] P
BB W A B W, FEARRE SCAS R A i rL T R bR AT AR R SR R R R RIS
T78iZ4T (run to line).

16(20)




3Andesight RDS fi 5 R 3.6Andesight P& 1) 5 H 2o A 5 i

[E 3-11 Debug 4N 4R

45 Debug_ 22 = 5 ¥, Terminate and Relaunch (restart the debug process)
LS N | ) | i - 0e Resume (run to next breakpoint)
v $ ac250-demo.adx [MCU Program] Suspend (Pause the running program)
v B Process ® Terminate (Stop the debug process)
v o Thread #1 (Suspended : User Request) ¢ Disconnect (disconnect the debug cable)
= start() at start.5:23 Oxc i connect to a process
s gdb(7.12.50.20170302)-0 2. step into (run into the fucntion)

= step over (run to next line)
. step return (return to upper level function)
i# Instruction Stepping mode (run one disassembly-code sentence at a time)

K 3-12 LA E . Friios N A ILM A SErs AT L4 <
RIAZ

B 3-12 C4miE SR BEO

E) console |[?! Problems |[C] Properties GDB Comnq |Z=" Disassembly &3 = 8
|Er1ter location here V|| & <‘}==':> @| ]

aw a3, el (=p) ~
=W ad, 64 (sp)
fsd £s0,184 (a3)
sw a6,68 (sp)
aw 31,12 (a3)
£1d ft5,112 (sp)
va_start( args, format );
sWw 53,224 (sp)
retorn print( &out, format, args ):

3.6 Andesight NER B OKRERFZE

] 3-13 &y Andesight 4 &[] UART Terminal &% % Giifi, a5
F, EAETREBSE R A7 Window->Show View->Terminal, F77F Terminal
M, $8)5 s open aterminal #5411, Hrigt—> e 0 & o 1B i i H 5 (7
FEREMHE LA P A H ) PR RESHUS U st OK JHRIEH .

IPUG546-1.0 17(20)




3Andesight RDS {#i H ¥ 3.7VIRTUAL HOSTING

[# 3-13 Andesight B & A%

A Launch Terminal O x

Choose terminal: Serial Terminal ~

Settings

Port: COM14 v

Baud Rate: | 38400 v

Data Bits: 8 v

Parity: Non ~

- b . & Terminal &3 1 ® ob S v=0
How Gontrot R o 1 Serial COM14 (10/30/18 4:3] PM)

Tz | 1f you see all messageg@in UPPER case, then nds_write(
Encoding: | Default (1S0-8859-1) v ~== deme printf: end =

»> demo printf: start <<

@ Cancel Open a Terminal

BARME R i, SISO
AndeSight RDS_v3.1_User Manual_UM170 V1.0.pdf, AJ7E %23 H i
doc #12 FHE.

3.7 VIRTUAL HOSTING

Andesight $2 4t —Fh# {5 5 1 7 \——Virtual Hosting. "] 7E1E4T F L
W, 83 console % printf (58, WK 3-14 s, &HTFATE
BERE UART i A, S4T7T Build Settings 51, £ Andes C
Linker->General #3201, /A)i% Virtual Hosting i3, 28 54T FF
src/config/config.h U4, 171 % %€ X #define VIRTUAL_HOSTING, E 4 1%,
RIAT7E A BB Virtual Hosting

TEVEREMAZ, Virtual Hosting R SZRR7E A R AR . i N URE
FFAEH R _EBRAMIE AT, A SCHF Virtual Hosting i vE 2. .

[# 3-14 i1 Virtual Hosting £ Console & O#HITENHE
E) Console &3 |2 Problems| ] Properties GDE Command }_ﬁTarget Mana

demo_ae250_exFlash_gowin.adx [MCU Program] demo_ae250_exFlash_gowin.adx
Hello world!
The RISC-V MCU AE250 is running...

IPUG546-1.0 18(20)




4 TRERER S TR 1

4.1 TFEMEAR

4.1 TI24E4R

IPUG546-1.0

TR Ti2RA

TEFEE TRERS, mlIEf) CERENRA “2 L 7. “Hello world TF2” f1

demo_ae250_exFlash_gowin, —ANiEIi, HEFEALH
demo_ae250_exFlash_gowin &5, iX&—/MMRIE GOWIN FPGA AT
AL B 1 TFERH, W& T BSP (Board Supporting Package, HR 2% 37 #545)
ANHAD — 28 A L S, AT AR 3047 E G A7 AT

10.

TREASEAR B B S A T

src/bsp/ae250/ae250.h: %A H A RGN Bl E . AN A A7A 8 A
HITIR 2 5 (152 o P e U AE250 (1250 B RF— 2
src/bsp/ae250/ae250.c: reset_handler & U2 Jo SR A REF AN,
AN HHLEHAT main KA BTHAT T UART W8 RI#AE, HRYIE AE250
(R B0 B R BT 75 1 UART it 1 10 B T 7 B e
src/bsp/config/config.h: Z 30L& T #9107 2 7228 s
Hrh#define BUILD_MODE 1] 5E XA BUILD_LOAD ¢ BUILD_BURN;

BUILD _LOAD X7 EHIZLME B e A7 it2s ILM 1, — B H T
DEBUG H};

BUILD_BURN FE/~ 25 F# 2| SPI Flash /1, L HJ55EM SPI Flash
PR ILM ST, & T KA

5 AN3E UOA#define VIRTUAL_HOSTING, 1 54# A virtual hosting
AT R, FR 72 2 T IF, UL printf ANFEE UART SRSZEL,
FTENE B4 AL Console & M A3t 47 EoR;

start.S: JL4iE 5 5 UL S

loader.c: bootloader 3, HF M SPI Flash J530;

ae250.sag: sag A& fm L EHE B X1 Scattering-and-Gathering 4% 7 i
A, AT ARE S IA . FEERERZ, ae250.sag H1f1 memory map

19(20)




4 TREREAR J TR 4.2 TR

SHFE S AE250 IS HUREF—5L;

11. src/bsp/driver: i% H 5% F A& A U, ae250 Jy AE250 FI3Rsh A,
include 1 43X 3) R 20 I #2101 5

12. src/bspllib: A& A, printf.c Hl E g X C FRUERE T BB
B, SEPLET UART it printf 15 2., read.c #1 8—AMEjH i8S
UART BB A Bk 3

4.2 TIERH

TIESEE, 13 H M demo SCAFS AT DL B AN A TRR

i, AT LSS N TR 7 2N # 8] Andesight 4R . IR PA R ik

FR . TRERBIWT:

1. demo-hsp-V5: J#E/NIE AE250 HHE (- HEAR PR YT AI RS, W LLIhEE,
HE W B AE250 3 2%k Andes StackSafe Extension &I ;
demo-pfm-V5: #E [ 2& Performance Monitor [Ih8E;
demo-powerbrake: 7R/ PowerBrake [f)IfE, PowerBrake ifid [&
fICHE 2 PUAT 8 2 11 AN 2 FRAI IS B S 3 SR I 1 A 7 1 47 T8 AT SIS B Jd ik
AR TREMIThAE . WFRLLThAE, 1E7E X E AE250 4] /41i%& Andes
PowerBrake Extension i ;

4. demo-plic-novector-V5: 7 A 35 I B X i Hh B2 i) 2 o) w7 7 e
N, FF4RAET machine timer AT pit timer iR ;

5. demo-plic-V5: JE/R IR BT 1) Wi dil 2 T AN, G R
i B R, 5 7R E AE250 S50 /4 1% Andes Vectored PLIC
Extension i ;

6. Dhrystone-V5: & —M% AE250 i&AC ) Dhrystone 127

IPUG546-1.0 20(20)
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